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1. Exhibitor Software 

    
The Exhibitor Software is a program for viewing and exporting both real-time and recorded data from 

the recorder. 

 

2. Installation 
 

This program will run on Windows XP/2000 and later. It is not compatible with earlier versions of 

Windows. 

 

1. Insert the Exhibitor CD into the CD drive. The setup program should launch automatically if your 

system is set to auto play CDs. If not, select the CD directory and run the setup.exe file.  

2. Exhibitor Software needs .NET Framework 2.0. If .NET Framework 2.0 is not installed on the PC, it 

will be installed first. This will take several minutes. Make sure you have network access. 

 
3. After .NET Framework 2.0 is installed, the installation will launch ñWelcome to Exhibitor Setup 
Wizardò. 

4. Accept the license agreement and the default install directory or modify as needed. 

5. Decide whether you want a desktop icon and check the box if you do. 

6. Accept the default install directory or modify as needed. 
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3. Using Exhibitor Program 

3.1 Starting the Program 

 

The Exhibitor software has the following main features: 

¶ It can display information from existing data file in summarized, tabular and graphic formats. 

¶ It is capable of monitoring an external device (through the OPC server). The user can manage 

different widgets. 

¶ It can export the data to Excel. 

 

 

To start the program, click the desktop icon if installed (shown left), or use the Windowôs 

Start menu. This will launch the main dialog. 

 

If the master password is enabled, the main dialog starts in the Data, Graph page. 
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Otherwise, it starts in the Login page. 

 
 

To enable the master password, please see Chapter 3.3 System Setup. 

 

There are five major tabs in the workspace: 

Login Login to the program 

Data Show data in a file 

Remote Show remote device values 

Real Time View Show all widgets in a project file 

Config FTP to the device and view Config file 

 

The Data tab page has six sub tag pages: 

Detail Shows each individual channel graph and summary of all channels 

Graph Shows a graphic representation of the data 

DataTable Shows all data points in a table 

Alarm  Shows all alarm points in a table 

Event Shows all events in a table 

Memo Shows all memos in a table 

 

Remote tab page has three sub tab pages: 

Device Manager Connects to multiple OPC server and displays all selected items 

Design Page Creates different widgets and displays real time value 

Real Time Record Creates record widget and records data point to a file 
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The pull-down menu items are: 

File Allows the user to open a data file or exit the program 

View View the Exhibitor log in file 

Setup Allows the user to customize the program 

Tool Connects to one OPC server and displays all items on it 

Help Provides help file or information about the software 

 

The icons from left to right are: New, Open File, Search and Log Off. 

 
 

3.2 Logging in to the Program 

 

The password option is disabled by default when the software is installed. The Login page is not 

enabled. This option can be modified in the password dialog, which is explained in the next section 

System Setup. The User can be added as well.  

 

If the password option is enabled, the user has to login first. Otherwise, the program cannot do 

anything. 

 

If you want to change the password, check the check box  when logging in. 

The password change dialog will appear (as shown below). 

 

 
 

When changing the password, the user id is grayed out. Type the new password and confirm it. If the 

two donôt match, you will have to try again. 
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3.3 System Set-Up 

 

There are a number of items that can be set up before using the program, although these default to 

useable options. 

 

The Setup menu has the following options. 

 

3.3.1 Language ï The default is English. It is simple to add language files (see Appendix A). 

If there is a language file in the Exhibitor installation directory that contains languages 

besides English, these will be shown and the user can select the language. 

3.3.2 Preferences ï  

3.3.2.1 Decimal Places ï Determines how numeric data will be displayed. Default is 3.  

3.3.2.2 Auto Scale ï Determines if all data points will fit Y-Axes for all channels. 

3.3.2.3 Remember Previous Directory ï Determines if the program needs to remember 

the directory when opening the data file. 

3.3.2.4 Channel Label ï Determines if the program will display the channel number or 

channel engineering units for the buttons on the graph page. 

3.3.3 Features ï Allows the user to upgrade from the free demo (default) version to the Lite or 

Full version. Select Update and enter your serial number in the spaces. Upgrades can be 

purchased from your distributor. Use the pull-down menu Help ï About to see what 

feature you have. 

3.3.4 Password ï Allows the program to enable the password option and add, update or delete 

users. 

 

 
 

The user can enter the user name, check active or not, choose the user level, expiration 

date, and enter a password.  Once all the options are selected/chosen, then click the Add 

button. This user will be added to the user list. 

 

The options when adding a user are: 

 

Active If the user is active, their user name and password have to match when 

logging in to the program. Otherwise, Exhibitor doesnôt check them. 

Retries The number of times the user can try to login before the user login fails. 
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Level There are three User Levels: User, Manager and Administrator 

 
 

User:  Cannot access setup. Can access all tabs except OPC Client, 

Device Manager in Remote page. In the Design Page, the 

user can view real time display, but cannot change the 

widgets. 

Manager: Access to everything except Password and Language. 

Admin:  Access everything. 

Expires The user will expire on this date. 

Password Enter the password to be used for this user. 

Auto Logout The program will automatically logout the user after this amount of time. 

Old Password  The user needs to type the correct old password in order to change the 

password.  

Add Adds a user to the user list. The list box on the bottom left on the dialog 

shows all users. 

Update    Modifies a userôs password. 

Delete Choose one of the users in the list box and click delete. That user will be 

deleted from the list. 

Enable Enables the password option. The check box is disabled if there is no user 

in the list. After adding at least one user, the check box will be enabled.  

 

After no mouse activity for 5 minutes, the user is automatically logged out. 

 

If the user wants to login as a different user name, he/she can click the Log Off  button. The 

program goes to the login page and the user can re-login. 

The Log Off button looks like: . 

 

3.4 Loading Data File 

To load a data file, click File->Open or click the file open icon . 

 

If the loading file is bigger than 100000 bytes, an endless progress bar dialog appears.  
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There are six tab pages for loading data files. 

 

 
 

Detail Shows each channel in different tag page and a summary table 

Graph Shows all channels in one graph 

DataTable Shows all data points in a table 

Alarm  Shows all alarm points in a table 

Event Shows all events in a table 

Memo Shows all memos in a table 

 

3.4.1 Graph Window 

 

In the example below, the file Sample.dat was loaded with the Auto Scale off.  

 

 
 

There are eighteen channels (show below). 
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3.4.1.1 Graph Radio Buttons 

 

There are a series of radio buttons along the left side of the Graph window. Each radio button 

represents a channel with the correct color of that channel. Each channel has its own Y-Axes. 

The maximum and minimum of the Y-Axes is defined in the configuration in the data file. 

The configuration also defines the channel color and engineering unit. In the above example, 

maximum of channel 1 is about 750 °F. Minimum is about -454 °F. Its color is white.  

 

If you click the Chan 2 radio button, the graph changes as seen in the below dialog. 

 

 
 

The color of the Y-Axes changes to red. The Maximum of channel 2 is 160 Seconds. 

Minimum is 0 Seconds.  

 

Each time a different radio button is selected, the graph will change accordingly. 

 

3.4.1.2 Graph Buttons 

 

The graphic area is fully interactive. Data can be zoomed and scrolled, the interaction 

controlled by the icons above the graph.  

 

  - Select 

This is the default cursor. It is used to scroll the trends horizontally and vertically by simply 

right clicking in the graphics area. Traces can be scrolled individually by clicking and 
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dragging the individual vertical scales or together by clicking and dragging in the graphics 

area. 

 

  - Stretch 

Click this button to stretch (zoom) or shrink the graph along the x-axes (time) and y-axis 

(scale). Traces can be zoomed individually by clicking and dragging the individual vertical 

scales or together by clicking and dragging in the graphics area. 

 

   - Zoom In 

Click this button to zoom in the graph. 

 

   - Zoom Out 

Click this button to zoom out the graph. 

 

   - Zoom Window 

Click this button to zoom to a user-defined window. When clicked, the cursor will turn into a 

draw window tool. Draw a window around the area of interest by holding the right mouse 

button and dragging the window. On release, the window area will fill the graphics screen. 

 

    - Zoom All 

Click this button to fit all data into one screen. 

 

    - Cursor 

Click this button to enable the cursor. Once enabled, right click anywhere on the graph and 

select a channel to lock the cursor to that trace.       
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As the cursor is dragged along the time base, the cross-hairs will track the trace and the pop-

up box will show details about the point in the cross-hairs. The cursor will turn to the finger 

pointer whenever the cursor can be dragged.  

 
  

 

   - Scroll to End 

Click either the left or right scroll button to jump to the start or end of the data. 

 

 - Original Scale 

Click this button to make the X and Y-axes to the original scale from when the data file was 

loaded. 

 

   - Print 

Click this button to show the print setup dialog. 

 
 

The user can choose the printer, change orientation and margins. The default print page is the 

current page. If the user wants to print all, he/she needs to input the total number of pages 

he/she wants. The program will divide the whole loaded data file to be equal to that range 

and print. 
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3.4.1.3 Channel Set Up 

 

Right click the mouse anywhere on the graph to display a pop-up menu.   

 

 
 

Select Setup from this menu and the Channel Setup dialog will appear. 

 

 
 

The Channel Setup dialog allows the user to modify the properties of each channel. 

Channel Selects a channel 

Visible Turns the trace on or off for the selected channel 

Marker Type  Identifies the actual points recorded. The trace is extrapolated 

between these points. The points can be marked by a square, circle 

or diamond. The user can also select None for no marker. 

Marker Size Adjusts the size of the marker on the points. 

Line Type Identifies the trace type. It can be solid, dashed or dotted. 

Line Thickness Adjusts the thickness of the trace. 

Data Trace Color Changes the trace color for the selected channel. 

Alarm Trace Color  Changes the alarm trace color for the selected channel. 
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3.4.1.4 Graph Background Color 

 

Right click the mouse anywhere on the graph to display the pop-up menu.  Highlight 

Background Color and there will be two menu items. 

 

 
 

Choose ñSelectò to open the Color dialog, which allows the user to select a different 

background color. 

 
 

If ñSave as Defaultò is selected, the selected background color will be saved to the registry. 

The next time Exhibitor is run, the graph will use that color as the default background. 

 

3.4.1.5 X-Axes Color 

 

Right click the mouse anywhere on the graph to display the pop-up menu and highlight X-

Axes Color. Similar to Background Color, there are two menu options: Select and Save as 

Default.   Choosing ñSelectò will open the color dialog to allow the user to change the X-

Axes color. Choosing ñSave as Defaultò will save the selected color to the registry to be 

used next time the software is run. 

 

3.4.1.6 Other Information  

 

There is a scroll bar and two buttons under the trend graph. 

 

Scroll Bar Scrolling the scroll bar will move the trend to the correct position.  

For example, if the scroll bar is moved to 15% and the total data points for 

each channel are 1000, the 150
th
 data point will be the 1

st
 data on the screen. 
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   - Discontinued Button 

These will appear if there is a gap between the discontinued data points.  

 
 

Click these two buttons to have the trend step over the time discontinuities. 

 

Memory Use Information  A text box indicates how much memory is used on the PC. 

 
If the used memory is over 70%, the data file will stop loading. 

There is a forward button to continue loading the file. 

 

Forward Button  

Clicking this button will enable the program to continue loading the data file. If the file was 

loaded all at once, this button will be disabled. 

 

  - Synchronize Choice 

Checking this option will synchronize the Graph page and the individual channel graph in 

Detail page. If the trend in the Graph page is moved, stretched or zoomed, the individual 

graph in Detail page will do the same. 

 

Key Functions 

 

Page Up Moves the y-axes one page up 

Page Down Moves the y-axes one page down 

Up Arrow  Moves the y-axes up 

Down Arrow  Moves the y-axes down 

Left Arrow  Moves the x-axes left 

Right Arrow  Moves the x-axes right 

Shift + Page Up Moves the x-axes one page left 

Shift + Page Down Moves the x-axes one page right 
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3.4.2 Detail Window 

 

This page shows the individual channels and summary table. 

 

 
 

Each channel graph has the same graph buttons as the trend graph in the Graph tab page. It also 

has the scrollbar and data discontinuity buttons. They function the same as in the Graph tab page.  

 

On the bottom of the graph of each channel, there are additional text boxes that indicate 

information for that channel. 

 

 
 

Beside these text boxes is a table that is empty after the file is loaded. To fill the table with data, 

click the search button on the top of the dialog.   

 



 17 

A search dialog will appear with the start time and end time for that channel. 

 

 
 

Select a start date and end date and click OK.  The table will be filled with all data points on that 

channel between the specified start time and end time. The trend will be highlighted for all the 

searched data points. 
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Clicking on any value cell will allow the user to add a message on that data point on the graph. 

 

 
 

The summary table summarizes the information for all channels. 
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3.4.3 DataTable Window 

 

The DataTable Window shows the time and value of every data sample on each channel. This 

window is also used to export data directly into an ExcelÊ spreadsheet and save the table to a 

.csv file. It can also be used to highlight a specific point on the graph. 

 

 
 

 

3.4.3.1  Jumping to A Specific Point on The Graph 

 

If you double click a value in any channel value column in the DataTable, the program will 

highlight that point on the graphic window. The graph will be automatically scaled to show 

the unique point highlighted by a rectangular box as shown below: 

 

 
 

Move the cursor into the rectangle for precise information about the point. 



 20 

 

The graph is synchronized with the DataTable as well. First, put the marker on a channel (For 

example, channel 2).  

 

 
 

Move the cursor to the second marker. The cursor will become a hand. Double click the 

marker. The second row on the data table will be highlighted. 

 

 
 

 

3.4.3.2 Creating Report 

 

The Exhibitor has the ability to create custom reports to be exported to ExcelÊ directly. The 

user can select the entire data set (beware of large files) or highlighted rows in the table or 

choose specific dates and times using the filter. Also, the user can select what columns from 

the table to export. 
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To export all data simply click the ExcelÊ button  or Export button .  

To select multiple rows from the DataTable, click the left edge of the starting row to export. 

This will highlight the row. Then scroll to the last row to export and hold down the shift key, 

and click the left edge of the last row. This will highlight all the rows between the start and 

the end. Then click the ExcelÊ button or Export button. The spreadsheet will open 

automatically if using ExcelÊ or you can open the exported file later if the Export button is 

click. 

 

The report can be further customized by selecting which columns to include in the report. 

This is done via the Report dialog box.     

 

 
 

The Include Columns check boxes determine which columns of the data table will be 

exported to the spreadsheet. Simply select the data you want. 

 

Below the Include Columns window is the Filter. This is yet another easy way to limit what 

data is exported to the spreadsheet. You can filter data by Date or Time or Both simply by 

checking the relative boxes as shown below. 

 

 
 

The From: and To: data entry areas default to the start and end times of the data in the table 

to be exported and can be edited by the user to specify an exact time frame for export. Once 

all parameters are set, press the ExcelÊ button and the data will open in an ExcelÊ 

spreadsheet.  
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When exporting into ExcelÊ, the user can select the desired Time Format in which the time 

will be displayed in Excel. 

 
 

There is also an option to view only an interval report.  Select the desired interval. 

 
 

Minute  ï View the first data point of every minute. 

½ Hour  ï View the first data point of every half hour. 

Hour ï View the first data point of every hour. 

Day ï View the first data point of every day. 

 

NOTE: You will need to have a valid copy of ExcelÊ on your PC. Otherwise use the 

Export button to name a .CSV file for later use. 

3.4.4 Alarm Table Window 

 

The Alarm Table is for alarm points. If there are no alarms, the window will be empty. 
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3.4.5 Event Table Window 

 

The Event Table is for events. If there are no events, the window will be empty. 

 

 
 

3.4.6 Memo Table Window 

 

The Memo Table is for memos. It shows all memos in the data file. 

 

 
 

Each memo is plotted on the graph as a yellow folder image. Double-click any cell in the memo 

row and a yellow rectangle will surround the correct yellow folder. 
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Double-click the yellow folder to see the content of the memo. If it is a message, a textbox will 

display the memo. 

 

 
 

If it is an image, it will be displayed in a graph. 
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3.5 Real Time Display 

 

Exhibitor can display data through OPC.  

 

Microsoftôs COM is the key for communication between OPC clients and OPC servers. DCOM 

permits OPC clients transparent access to OPC servers on remote computers. Default DCOM 

settings vary from system to system. Generally, default DCOM settings on the server machine 

restrict OPC client applications from accessing a remote OPC server. 

 

If you have difficulty connecting the Exhibitor application to an OPC server, temporarily turn off 

your computerôs firewall. To do so, click the Control Panel -> Security Center->Windows Firewall. 
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There are four ways to see real time data within the program: Device Manager Window, Design 

Page Window and Real Time View and OPC Client (under the Tools pull-down menu). 

3.5.1 Device Manager Window 

 

This window can show multiple servers (maximum 50). Each server can have multiple items 

(maximum 100). 

 

 
 

3.5.1.1 Add Server 

 

1. Click the Add OPC Server button. The OPCServerBrowser will appear.  
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2. Select a computer from the computer list (ROSALINDXPPRO for example) OR enter an 

IP Addresss (192.168.0.243 for example). 

 
3. Enter a description (Test1 or Test2 for example). 

4. Enter an Update Rate in seconds (Default is 1).  

5. Then click the arrow button between Computer List and OPC Servers. 

If there is no connection between the local PC and the device, a message will pop up. 

       
6. If connection is ok, the list box displays all OPC servers on the device. Select an OPC 

Server from the OPC Servers list (OPCLabs.KitServer2 or NDI.MiSvr.1 for example). 

7. Click OK.  The server name with the description is added to the OPC Device list in the 

Device Manager window.  
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8. Double-click the server name or right click it and select Add Item from the menu to view 

all OPC items under this server. 

 

 
 

There are two other items in this menu. 

 

Update Rate ï Modifies the server update interval. The default is 1 second. 

 
 

Delete Server ï Deletes this server from the OPC Device list. 

 

9. The Item List on the right side of the window will show all the items under this server. 

Click any server to expand child nodes. 
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10. Select an item from the Item List and click the left arrow button between OPC Device 

and Item List  to add the item to the server in OPC Device list. If the root node in 

the Item List tree is chosen, all children under the root are added to the server. Only the 

added items are displayed to the user.   
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You can also right-click an item in the Item List and select Add All for a root node or Add 

for a child item. 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

To delete an item from OPC Device, right click it and choose Delete Item. 

 

 
 

 OR 

Click the right arrow button between OPC Device and Item List.    

 

If you want to rename to OPC item to make more sense to yourself, right click the item and 

choose Rename as show above. The item becomes editable. Then type the name.  
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When adding another server, previously selected servers will disappear from the list, but they 

still exist. They are just hidden. 

 

To view all added servers, click the View All  button.   

 

All added servers will be listed in the left window.  Double-click any server to expand the 

tree and show all children. 

 
 

3.5.1.2 Running the Servers 

 

1. Click the Run button. A table with the server and its selected items replaces the Item List 

on the right side of the window. 

2. Check the Show Live check box if it is unchecked. The default is unchecked. After 

checking it, the table shows the real time value. 

 
 

If you want to modify the OPC Device list, you have to click Stop button. The table is gone 

and the Item List comes back. 
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3.5.1.3 Save OPC Device 

 

The program can save all added OPC Device Servers and reload them. This saves time and 

you donôt have to go to the OPC Server Browser window to add servers and reconnect. 

 

1. Click the Save button. 

2. Select a Save in location 

3. Enter a File name (e.g. dev2). The extension of the file is .dev. 

4. Click Save. 

 

 
 

The File name (e.g. dev2.dev) will be added to the OPC Device combo box. 
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3.5.1.4 Reload Saved Device 

 

1. Select blank.dev from the OPC Device combo box. All items in the left window will be 

gone. 

 

 
 

2. Select the desired saved OPC Device (e.g. dev2.dev) from the OPC Device combo box. 

All Device Servers are added to the left window. 
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3.5.1.5 Delete Saved Device 

 

1. Click the Delete button.  

2. Select a file to delete from the list and then click OK . 
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3.5.2 Design Page Window 

 

The user can customize different widget and show different OPC items. All OPC items are based 

on Device Manager window. 

 

 
 

 

3.5.2.1 Creating a Widget 

 

1. Click the (Select a Control) combo box. 

 

 
 

2. Select a widget type (Small Thermometer for example).  
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3. The Design Window appears. 

 

 
 

There are three major parts on this window: 

OPC Items ï OPC item tree is based on Device Manager window  

Widget Setup ï Configure the Labels, Scale and Alarms on the widget 

Widget  ï Customize the widget 

 

4. First set up your labels.  Labels can be Text (e.g. Engineering Units) or an OPC Item. 

 

With the Labels tab selected, click the Label combo box and select a label. Then click the 

Create button.  

 

 
 

For example, create Label1.  

 

The label can be deleted by clicking the Delete button. 
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All Labels are created on the top left corner on the widget. 

 

 
 

If you put the mouse cursor over Label1 the cursor becomes a hand. Then you can drag 

the label to move it to where you want. 

 

 
 

To make Label1 Text, type text into the Text box and you will see Label1 change to the 

text you typed in the widget on the right. 

 

For more advanced details within a widget, you can add more Labels, which can indicate 

titles or values such as max and min.   

 

For instance, you can follow the same steps to create Label2, but instead of making the 

label text, select an OPC Item from the list on the left to make the Label2 equal to that 

OPC Item. 
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The example below shows Label2 assigned to the OPC Item ChannelEngUnit_02.  This 

label will continuously change as the value of ChannelEngUnit_02 changes. 

 
 

5. Next select the Scale tab to configure the Scale, which actually assigns a value for the 

widget. 

 

To assign OPC item to the scale, click the OPC Item text box so the cursor is in there. 

Then click any OPC item (ChannelValue_02 for example). 

 
 

You can configure Min and Max by assigning a number or an OPC item. By default, they 

are assigned by 0 and 100. To assign an OPC item, click the Use OPC Item check box. 

Click in the Min or Max text box, and then select an OPC item.  

 

You can also change the color of different divisions, the scale and the point.  
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6. Next select the Alarms tab to configure the Alarms. 

 
 

There are two ways to configure alarm set points. By default, it is set by internal alarms. 

That means that the alarm set point is configured by the device. This only applies to the 

widget that its scale is assigned by ChannelCom* item. A red label Alarm  appears on the 

top of the widget if there is an alarm.  

 

If you want to configure the set point yourself, uncheck Internal Alarm check box and 

enter the numbers in the two Set Point text boxes. 

 

7. Once you are done setting up the widget, check the Activate check box. 

8. Click the OK  button. 

 

The configured widget is added to the main design page. 

 

 
 

Double-click the widget to go back to the design window so you can change the 

configurations. 
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Widget Types: 

Thermometer (Small or Large)  

Digital (Small or Large, type 1 or 2) 

Bar (Small or Large) 

Trend 

 

Digital widgets do not have Min and Max. These two areas are disabled. 

You can also choose Auto Precision for the scale value:  

 
 

Or customize the precision yourself. 

 

 
 

Bar widgets have scales with three value sections for alarms. They can be assigned different 

colors.  
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The Trend widget has additional tabs to configure Channels, the Display and UpdateRate. 

 
The created labels are movable and assigned to OPC items like other widgets. 

 

The trend widget has eighteen channels by default. Each channel needs to be configured 

separately.  
 

To configure Channels click on the Channels tab. 
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Delete any channels not wanted by clicking on the channel and then clicking the Delete 

button. 

 
 

To add channels, click the Add button and a list of the additional channels will appear. Select 

one to add.  

 
 

To configure a specific channel: 

o Select the Channel from the list 

o Select the Marker Type, Marker Size, Line Type and Line Thickness.  

o Change the trace color if desired. 

o Assign an OPC Item to the channel by clicking in the OPC Item text box and then 

clicking on an OPC Item from the OPC Item list. 

o Set the Min and Max for the y-axes. You can enter specific numbers or assign an OPC 

item. 
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o Click on the Alarm tab. Configure the alarm set points and color.  The alarm color is the 

same as the channel trace color by default.  

 
 

o Click on the Enabled tab. Unchecking the Enable check box makes the trace invisible. 

 
 

Follow the same steps to configure additional channels. 
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To configure the Trend Display Setting, click on the Display tab. 

 

 
 

Enter a name that will be the name of the trend graph.  

 

There are three trend styles. The only difference is trend size. 

 

 
 

Each channel has its own y-axes. You can let the trend only show one specific channel y-

axes: 

 
 

OR rotate all channel y-axes at a specific time interval (10 seconds for example).  

 
 




